
Doc ID VIEWME-IN003C-EN-P

Installation Guide

VIEWME-IN003C-EN-P-ttlpg.qxd  10/9/03  4:24 PM  Page 1



Contacting 
Rockwell Software

Technical Support Telephone—440-646-5800
Technical Support Fax—440-646-5801
World Wide Web—http://www.software.rockwell.com or http://support.rockwellautomation.com

Copyright Notice © 2003 Rockwell Software Inc., a Rockwell Automation company. All rights reserved.
Printed in the United States of America.
Portions copyrighted by the Allen-Bradley Company, LLC, a Rockwell Automation company.
This manual and any accompanying Rockwell Software products are copyrighted by Rockwell 
Software Inc. Any reproduction and/or distribution without prior written consent from Rockwell 
Software Inc. is strictly prohibited. Please refer to the license agreement for details.
VBA and DCOM, Copyright 1996, 1997 Microsoft Corporation. All rights reserved.
This software is based in part on the work of the Independent JPEG Group.

Trademark 
Notices

The Rockwell Software logo, RSLinx, RSLogix 5, RSLogix 500, RSTools, RSView, RSView Machine 
Edition, RSView ME Station, RSView Studio, A.I. Series, Advanced Interface (A.I.) Series, 
ControlView, FactoryTalk, Object Smart Path, RAC6182, and WINtelligent LOGIC 5 are trademarks 
of Rockwell Software Inc., a Rockwell Automation company.
PLC-5 is a registered trademark, and ControlNet, Data Highway Plus, DH+, MicroLogix, 
MobileView, PanelView Plus, PLC-5/20E, PLC-5/40E, PLC-5/80E, SLC, SLC 5/01, SLC 5/02, SLC 
5/03, SLC 5/04, SLC 5/05, SoftLogix, and VersaView are trademarks of the Allen-Bradley Company, 
LLC, a Rockwell Automation company.
Adobe and Acrobat are registered trademarks and Reader is a trademark of Adobe Systems 
Incorporated. TrueType is a trademark of Apple Computer, Inc. AutoCAD is a registered trademark 
of Autodesk, Inc. Ethernet is a registered trademark of Digital Equipment Corporation, Intel 
Corporation, and Xerox Corporation. Modicon is a registered trademark of Groupe Schneider. Intel 
and Pentium are registered trademarks of the Intel Corporation. Zip is a trademark of Iomega 
Corporation. KEPServerEnterprise is a trademark of Kepware Technologies. ActiveSync, ActiveX, 
Microsoft, MS-DOS, OpenType, Visual Basic, Windows, and Windows NT are registered trademarks 
of Microsoft Corporation in the United States and/or other countries. OPC is a trademark of the OPC 
Foundation.
All other trademarks are the property of their respective holders and are hereby acknowledged.

Warranty This Rockwell Software product is warranted in accord with the product license. The product’s 
performance will be affected by system configuration, the application being performed, operator 
control, and other related factors. The product’s implementation may vary among users. 
This manual is as up-to-date as possible at the time of printing; however, the accompanying software 
may have changed since that time. Rockwell Software reserves the right to change any information 
contained in this manual or the software at any time without prior notice.
The instructions in this manual do not claim to cover all the details or variations in the equipment, 
procedure, or process described, nor to provide directions for meeting every possible contingency 
during installation, operation, or maintenance.
Doc ID ViewME-IN003C-EN-P
December 2003



Contents
Chapter 1
Introducing RSView Machine Edition ..................................................................... 1

About RSView Machine Edition ................................................................... 1
RSView Studio..................................................................................................................1
RSView ME Station......................................................................................................... 1

Additional software.............................................................................................. 2

The RSView Machine Edition tools........................................................... 2

Chapter 2
Installing and activating RSView Studio and ME Station ............... 5

System requirements..........................................................................................5

Installing ...................................................................................................................... 5
The Installation Assistant ............................................................................................... 5
Uninstalling ....................................................................................................................... 6
Installation steps .............................................................................................................. 7
Installation summary ....................................................................................................... 8

Activating .................................................................................................................... 9
About the Activation disk .............................................................................................. 9

Starting ......................................................................................................................... 9
Starting RSView Studio manually ................................................................................10
Starting automatically ....................................................................................................10

Using sample applications............................................................................10

Chapter 3
Installing and activating RSView ME Station on Windows 2000 
or 
Windows XP ........................................................................................................................................ 13

System requirements........................................................................................13
Contents     iii



Installing .................................................................................................................... 13
Uninstalling..................................................................................................................... 14
Installation steps ............................................................................................................ 15
Installation summary ..................................................................................................... 15

Activating.................................................................................................................. 16
About the Activation disk ............................................................................................ 16

Starting ....................................................................................................................... 17
Starting RSView ME Station manually....................................................................... 17
Starting automatically .................................................................................................... 17

Using sample applications ........................................................................... 18

Chapter 4
Running RSView ME Station on a PanelView Plus terminal ...... 19

System requirements ....................................................................................... 19

Installing .................................................................................................................... 19

Reinstalling .............................................................................................................. 19

Starting ....................................................................................................................... 20
Starting RSView ME Station manually....................................................................... 20
Starting automatically .................................................................................................... 20

Running applications ........................................................................................ 20

Using sample applications ........................................................................... 20

Chapter 5
Running RSView ME Station on the VersaView CE terminal .... 23

System requirements ....................................................................................... 23

Installing .................................................................................................................... 23

Reinstalling .............................................................................................................. 23
Using ActiveSync........................................................................................................... 24
Using the Firmware Upgrade Wizard......................................................................... 25

Starting ....................................................................................................................... 26
Starting RSView ME Station manually....................................................................... 26
iv     RSView Machine Edition Installation Guide



Starting automatically ....................................................................................................26

Running applications ........................................................................................26

Using sample applications............................................................................26

Chapter 6
Running RSView ME Station on a MobileView terminal ................. 29

System requirements........................................................................................29

Installing ....................................................................................................................29

Reinstalling ..............................................................................................................29
Using ActiveSync ...........................................................................................................30
Using the Firmware Upgrade Wizard .........................................................................31

Starting .......................................................................................................................32
Starting RSView ME Station manually .......................................................................32
Starting automatically ....................................................................................................32

Running applications ........................................................................................32

Using sample applications............................................................................32

Chapter 7
Getting the information you need ............................................................................. 35

Using the User’s Guide ....................................................................................35

Using RSView Studio Help ............................................................................35
Viewing the Help contents ...........................................................................................36
Using the index ..............................................................................................................37
Finding words or topics ................................................................................................38

Using the RSView online user’s guides ...............................................39
Viewing the guides.........................................................................................................39
Finding information ......................................................................................................39
Printing pages .................................................................................................................40
Using the online guide for the reader .........................................................................40

Technical Support Services .........................................................................41
Try the user’s guides and Help first ............................................................................41
Information on the Internet.........................................................................................41
Contents     v



Contacting Rockwell Software Technical Support..................... 43
When you call ................................................................................................................. 43
vi     RSView Machine Edition Installation Guide



Chapter
1 Introducing RSView Machine 
Edition

About RSView Machine Edition
RSView Machine EditionTM is software for developing and running human-
machine interface (HMI) applications. RSView Machine Edition is designed 
for monitoring and controlling automated processes and machines.

For information about using RSView Machine Edition to create and run 
applications, see the RSView Machine Edition User’s Guide.

RSView Studio
RSView StudioTM is a Windows®-based software program for creating 
machine-level monitoring and control applications in Microsoft® 
Windows® 2000 and Windows XP. 

RSView Studio contains the tools you need for creating all aspects of an HMI 
application, including real-time animated graphic displays, trends, and alarm 
reporting.

RSView ME Station
RSView ME StationTM provides the run-time environment for the applications 
you design using RSView Studio. You can run machine-level applications on 
PanelView PlusTM terminals, on the VersaViewTM CE and MobileViewTM 
terminals with the Windows CE.NET 4.1 operating system, and on computers 
that use the Windows 2000 or Windows XP operating system.
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Additional software
The RSView Machine Edition CD also includes four additional software 
options:

FactoryTalkTM Automation Platform installs software that is shared among the 
components of RSView Enterprise. The FactoryTalk Automation Platform 
must be installed before RSView Studio or RSView ME Station can be installed. 

RSLinx EnterpriseTM RSLinx Enterprise is a communication server built around 
FactoryTalk technology to assist in developing and running your RSView ME 
applications. It is an OPCTM 2.05 compliant server and will run on  a variety of 
platforms ranging from PanelView Plus dedicated terminals to desktop 
computers.
RSLinxTM for RSViewTM is software that provides communications to a wide 
range of devices, such as ControlLogix processors. RSLinx for RSView is an 
OPC-compliant data server.

Adobe® Acrobat® ReaderTM 5.1 is software for reading the online RSView 
Machine Edition User’s Guide. You can also use the software to print the User’s 
Guide. 

This Installation Guide is also available online. For more information, see 
Chapter 7.

The RSView Machine Edition tools
These tools are installed with RSView Studio:

Diagnostics Setup is software for setting up FactoryTalk Diagnostics 
destinations and message routing.

Diagnostics Viewer allows you to view FactoryTalk Diagnostics messages 
using the Windows Event Viewer.

Transfer Utility is software for moving a run-time machine-level application 
(.mer file) from the development computer to the PanelView Plus, 
VersaView CE, or MobileView terminal.

Tag Import and Export Wizard is software for importing or exporting the 
RSView tag database.

Application Manager is software for renaming, copying, deleting, backing 
up, and restoring applications.
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This tool is installed with RSView ME Station:

DeskLock is software that prevents Windows 2000 and Windows XP users 
from exiting the RSView application at run time. You cannot use DeskLock 
if you are running your application on a PanelView Plus, VersaView CE, or 
MobileView terminal.
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Chapter
2 Installing and activating 
RSView Studio and ME 
Station

System requirements
To run RSView StudioTM, the requirements are:

Personal computer with an Intel® Pentium® II processor. (300 MHz or 
faster processor recommended.) 

Memory (RAM). 128 MB (256 MB recommended with Windows XP).

Hard disk space. Minimum 100 MB.

Operating system. Microsoft® Windows® 2000 Professional with Service 
Pack 4 or Microsoft Windows XP Professional with Service Pack 1.

Installing 
The steps below explain how to install the RSView Studio and RSView ME 
StationTM software from the CD-ROM to your computer.

The installation process creates program folders and modifies registry entries. 
In order to make these modifications, the user that is currently logged in must 
have administrative rights on the Windows 2000 or Windows XP computer on 
which RSView is installed (for example, the Windows 2000 Administrator 
account has these rights).

The Installation Assistant
For more information about the installation process, click View Installation 
Assistant on the CD-ROM. The RSView Enterprise Installation Assistant is a 
help file that tells you how to install the product correctly.
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Uninstalling
If you are upgrading from an earlier version of RSView Studio, you must 
uninstall the earlier versions of both RSView Studio and RSLinx EnterpriseTM 
before upgrading. If you have an earlier version of RSView ME Station 
installed, you must uninstall it before installing RSView Studio and RSView ME 
Station. 

If the FactoryTalk Automation Platform is installed, it must be uninstalled 
before reinstalling. If you are upgrading from a previous version to version 
3.10.00, the FactoryTalk Automation Platform will not appear. However, if you 
have to reinstall the current version for any reason, remember to uninstall the 
FactoryTalk Automation Platform first.

To uninstall FactoryTalk Automation Platform

1. Click the Windows Start button, select Settings, and then click Control 
Panel.

2. In the Windows Control Panel, double-click Add/Remove Programs.

3. Click FactoryTalkTM Automation Platform, and then click Remove.

4. In the confirmation dialog box, click Yes.

5. When the uninstall process is complete, click Close to close the Add/
Remove Programs dialog box, and then close the Control Panel.

To uninstall RSView Studio and/or ME Station

1. Click the Windows Start button, select Settings, and then click Control 
Panel.

2. In the Windows Control Panel, double-click Add/Remove Programs.

3. Click RSView Machine EditionTM, and then click Remove.

4. In the confirmation dialog box, click Yes.

5. When the uninstall process is complete, click Close to close the Add/
Remove Programs dialog box, and then close the Control Panel.

To uninstall RSLinx Enterprise

1. Click the Windows Start button, select Settings, and then click Control 
Panel.

2. In the Windows Control Panel, double-click Add/Remove Programs.

3. Click RSLinx Enterprise, and then click Remove.
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4. In the confirmation dialog box, click Yes.

5. When the uninstall process is complete, click Close to close the Add/
Remove Programs dialog box, and then close the Control Panel.

Installation steps
To install RSView Studio and ME Station

1. Close all open Windows programs.

2. Place the RSView Machine Edition CD in your CD-ROM drive. The CD 
should start running automatically.

If the CD does not start automatically, run D:\Setup.exe where D is the 
drive containing the CD.

3. In the RSView Machine Edition window, click Install FactoryTalk 
Automation Platform. When the installation finishes, click OK.

4. In the RSView Machine Edition window, click Install RSView Studio and 
RSView ME Station.

The Installation Wizard opens.

If you have not yet uninstalled an earlier version of RSView Studio, you 
must uninstall the earlier version before continuing. For instructions, see 
“Uninstalling,” earlier in this section.

5. Follow the on-screen instructions.

6. After the RSView Studio ME Station installation completes, the RSLinx 
Enterprise Installation Wizard opens. RSLinx Enterprise is required for 
run-time communications. Follow the on-screen instructions. 

7. If you are upgrading from version 1.5 or earlier, you are asked whether to 
move existing run-time application files to a new location. Click Yes or No.

8. You are prompted to activate the product you are installing. If activation is 
present from a previous installation, clear the Yes, Install Activation now 
check box, and then click Finish. 

If you removed the activation or if you are installing RSView Studio for the 
first time, leave the Yes, Install Activation now check box checked. Insert 
the Activation disk in the disk drive, and then click Finish.

9. If you are activating the software now, see Start\Programs\Rockwell 
Software\Utilities\Activation Help for detailed instructions.
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For more information about activation, see “Activating,” later in this 
chapter. 

Installation summary
The installation does the following:

installs the shared components for the FactoryTalk Automation Platform. 

installs RSView Studio and RSView ME Station in \Program 
Files\Rockwell Software\RSView Enterprise. This folder contains the 
RSView Studio software and tools.

installs RSLinx Enterprise in \Program Files\Rockwell Software\RSLinx 
Enterprise. This folder contains the RSLinx Enterprise files.

adds a \Program Files\Rockwell Software\RSUtil folder. This folder 
contains the Rockwell Software utilities needed for activating RSView 
Studio. It also contains the Rockwell Automation Services and Support Guide 
Help file.

adds a \Documents and Settings\All Users\Documents\RSView 
Enterprise\Images folder. This folder contains bitmap image files that you 
can use on graphic objects.

NOTE: In Windows XP, the Documents folder is called Shared 
Documents.

adds a \Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects folder. This folder contains sample 
applications for RSView Studio and stores applications that you create.

adds a \Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\Libraries folder. This folder contains graphic library 
component files and image files used in the library displays.

if you are upgrading from version 1.5 or earlier, provides the option of 
moving run-time application files and log files from the old location to 
\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME, to folders called Runtime and Logs, respectively.

For the RSView ME Station installation summary, see Chapter 3.
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Activating
RSView Machine Edition uses files that reside on the Activation disk to activate 
its Windows-based software packages. Without activation, RSView Studio runs 
in demo mode, allowing two hours of use and no more than five displays 
(including the three default displays).
During installation, the software prompts you to insert the Activation disk and 
move the activation key from the disk to the drive where you have installed 
RSView Studio.
For information about activating RSView ME station, see Chapter 3. For help 
see Start\Programs\Rockwell Software\Utilities\Activation Help.

About the Activation disk
The Activation disk (also referred to as a Master disk) activates RSView Studio. 
The Activation disk contains:

one or more activation files.
The activation file is the software “key” that activates your RSView Machine 
Edition product. Depending on what you purchase, your Activation disk has 
one or more activation files. For example, if your company purchases four 
RSView Studio installations, you require four activation keys. 
Multiple copies of the same software require activation keys with matching 
serial numbers. All of the activation keys can be on the same Activation disk.
a program called EvMoveW.exe that moves activation keys to and from 
computers.
a program called ResetW.exe that reactivates a damaged activation key.

You can move activation keys to and from the Activation disk. The programs 
EvMoveW.exe and ResetW.exe always stay on the Activation disk.

Activation keys

RSView Studio uses the activation key RSVME.STUDIO.

Starting
You can start RSView Studio manually, or you can set up the program to start 
automatically when Windows starts.

For information about starting RSView ME Station, see Chapter 3.
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Starting RSView Studio manually
In Windows 2000, click the Windows Start button, select Programs, and then 
click RSView Studio. In Windows XP, click the Windows Start button, select 
All Programs, and then click RSView Studio.

Starting automatically
To start RSView Studio automatically each time Windows starts, include a 
shortcut in the Windows Startup folder. 

To add RSView Studio to the Startup folder

1. Click the Windows Start button, select Settings, and then click “Taskbar & 
Start Menu.”

2. In the Taskbar and Start Menu Properties dialog box, click the Advanced 
tab. 

3. Click Add. The Create Shortcut dialog box opens.

4. Browse to the location of the Launcher.exe file, and then click the file 
name. The path is \Program Files\Rockwell Software\RSView 
Enterprise\Launcher.exe.

5. Click OK, and then click Next.

6. In the Select Program Folder dialog box, select the Startup folder, and then 
click Next.

7. Specify a name for the shortcut (for example, RSView Studio).

8. Click Finish, and then click OK.

Using sample applications
RSView Studio comes with sample applications that highlight features of the 
product. Most of these applications have two versions, designed for two 
different screen resolutions.

For example:

Overview_640x480.med 
Overview_800x600.med

A sample run-time application file (with the extension .mer) is included in each 
sample application’s directory. 
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The path to the sample applications is:

\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects. 

HMI projects contains a folder for each sample application.

If you haven’t activated RSView Studio, use the sample application Objects 5 
Screen Demo.med.

To open a sample application when you start RSView Studio

1. In RSView Studio, in the New/Open Machine Edition Application dialog 
box, click the Existing tab.

2. Click the name of the sample application to open, and then click Open.

To open a sample application after RSView Studio is open

1. In RSView Studio, click File, and then click Open Application.

If an application is already open, you are asked whether to close it. Click 
Yes. 

2. Click the name of the sample application to open, and then click Open.
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Chapter
3 Installing and activating 
RSView ME Station on 
Windows 2000 or 
Windows XP

System requirements
To run RSView ME StationTM on a computer that uses the Windows® 2000 or 
Windows XP operating system, the requirements are:

Personal computer with an Intel® Pentium® II processor. (300 MHz or 
faster processor recommended.) 

Memory (RAM). 128 MB  (256 MB recommended with Windows XP).

Hard disk space. Minimum 100 MB.

Operating system. Microsoft® Windows 2000 Professional with Service 
Pack 4 or Microsoft Windows XP Professional with Service Pack 1.

Installing 
The steps below explain how to install the RSView ME Station software from 
the CD-ROM to your computer.

The installation process creates program folders and modifies registry entries. 
In order to make these modifications, the user that is currently logged in must 
have administrative rights on the Windows 2000 or Windows XP computer on 
which RSView is installed (for example, the Windows 2000 Administrator 
account has these rights).
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Uninstalling
If you are upgrading from an earlier version of RSView ME Station, you must 
uninstall the the earlier version before upgrading. 

If the FactoryTalk Automation Platform is installed, it must be uninstalled 
before reinstalling. If you are upgrading from a previous version to version 
3.10.00, the FactoryTalk Automation Platform will not appear. However, if you 
have to reinstall the current version for any reason, remember to uninstall the 
FactoryTalk Automation Platform first.

To uninstall FactoryTalk Automation Platform

1. Click the Windows Start button, select Settings, and then click Control 
Panel.

2. In the Windows Control Panel, double-click Add/Remove Programs.

3. Click FactoryTalkTM Automation Platform, and then click Remove.

4. In the confirmation dialog box, click Yes.

5. When the uninstall process is complete, click Close to close the Add/
Remove Programs dialog box, and then close the Control Panel.

To uninstall RSView ME Station

1. Click the Windows Start button, select Settings, and then click Control 
Panel.

2. In the Windows Control Panel, double-click Add/Remove Programs.

3. Click RSView ME Station, and then click Remove.

4. In the confirmation dialog box, click Yes.

5. When the uninstall process is complete, click Close to close the Add/
Remove Programs dialog box, and then close the Control Panel.

To uninstall RSLinx Enterprise

1. Click the Windows Start button, select Settings, and then click Control 
Panel.

2. In the Windows Control Panel, double-click Add/Remove Programs.

3. Click RSLinx EnterpriseTM, and then click Remove.

4. In the confirmation dialog box, click Yes.
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5. When the uninstall process is complete, click Close to close the Add/
Remove Programs dialog box, and then close the Control Panel.

Installation steps
To install RSView ME Station

1. Close all open Windows programs.

2. Place the RSView Machine Edition CD in your CD-ROM drive. The CD 
should start running automatically.

If the CD does not start automatically, run D:\Setup.exe where D is the 
drive containing the CD.

3. In the RSView Machine Edition window, click Install FactoryTalk 
Automation Platform. When the installation finishes, click OK.

4. In the RSView Machine Edition window, click Install RSView ME Station.

The Installation Wizard opens.

5. Follow the on-screen instructions.

6. After the RSView Studio ME Station installation completes, the RSLinx 
Enterprise Installation Wizard opens. Follow the on-screen instructions. 
RSLinx Enterprise is required for run-time communications.

7. If you are upgrading from version 1.5 or earlier, you are asked whether to 
move existing run-time application files to a new location. Click Yes or No.

8. You are prompted to activate the product you are installing. If activation is 
present from a previous installation, clear the Yes, install Activation now 
check box, and then click Finish. 

If you removed the activation or if you are installing RSView ME Station 
for the first time, leave the Yes, install Activation now check box checked. 
Insert the Activation disk in the diskette drive, and then click Finish.

9. If you are activating the software now, see Start\Programs\Rockwell 
Software\Utilities\Activation Help for detailed instructions.

For more information about activation, see “Activating,” later in this 
chapter. 

Installation summary
The default installation does the following:
Installing and activating RSView ME Station on Windows 2000 or Windows XP     15



installs the shared components for the FactoryTalk Automation Platform

installs RSView ME Station in \Program Files\Rockwell Software\RSView 
Enterprise. This folder contains the RSView ME Station software and the 
DeskLock tool.

installs RSLinx Enterprise in \Program Files\Rockwell Software\RSLinx 
Enterprise. This folder contains the RSLinx Enterprise files.

adds a \Program Files\Rockwell Software\RSUtil folder. This folder 
contains the Rockwell Software utilities needed for activating RSView ME 
Station. It also contains the Rockwell Automation Services and Support Guide 
Help file.

if you are upgrading from version 1.5 or earlier, moves run-time application 
files and log files from the old location to \Documents and Settings\All 
Users\Documents\RSView Enterprise\ME, to folders called Runtime and 
Logs, respectively (unless you elected not to move the files).

Activating
RSView ME Station uses activation files to activate its Windows-based 
software packages. The activation files are on the Activation disk. During 
installation, the software prompts you to insert the Activation disk and move 
the activation key from the disk to the drive where you have installed RSView 
ME Station.

About the Activation disk
The Activation disk (also may be referred to as a Master disk) activates RSView 
ME Station. Without activation, RSView ME Station runs in demo mode, 
allowing two hours of use and no more than five displays (including the three 
default displays).

The Activation disk

The Activation disk contains:
one or more activation files.
The activation file is the software “key” that activates your RSView Machine 
Edition product. Depending on what you purchase, your Activation disk has 
one or more activation files. For example, if your company purchases four 
RSView ME Station installations, you require four activation keys. 
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Multiple copies of the same software require activation keys with matching 
serial numbers. All of the activation keys can be on the same Activation disk.
a program called EvMoveW.exe that moves activation keys to and from 
computers.
a program called ResetW.exe that reactivates a damaged activation key.

You can move activation keys to and from the Activation disk. The programs 
EvMoveW.exe and ResetW.exe always stay on the Activation disk.

Activation keys

RSView ME Station installed on computers running Windows 2000 or 
Windows XP uses the activation keys RSVME.RUN, RSVME.30, and 
RSVME.15. The particular keys on your Activation disk depend on the 
licensing you purchase, and determine how many displays your applications can 
contain:

RSVME.RUN comes with the license for 75 displays.

RSVME.30 comes with the license for 30 displays.

RSVME.15 comes with the license for 15 displays.

Starting
You can start RSView ME Station manually, or you can set up the program to 
start automatically when Windows starts. 

Starting RSView ME Station manually
Click the Windows Start button, select Programs > Rockwell Software > 
RSView Enterprise, and then click RSView ME Station.

The RSView ME Station dialog box opens. For information about the options 
in the dialog box, see Chapter 24 in the RSView Machine Edition User’s Guide.

Starting automatically
You can set up RSView ME Station to start automatically and run a particular 
application when Windows starts. For more information, see Chapter 24 in the 
RSView Machine Edition User’s Guide.
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Using sample applications
RSView StudioTM comes with sample applications that highlight features of the 
product. Most of these applications have two run-time versions, designed for 
two different screen resolutions.

For example:

Overview_640x480.mer
Overview_800x600.mer

The sample applications are located at this path on the development computer 
(the computer on which RSView Studio is installed):

\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects. 

HMI projects contains a folder for each sample application.

If you haven’t activated RSView ME Station, use the sample application 
Objects 5 Screen Demo.mer.

If you’re running RSView ME Station on a computer that doesn’t have RSView 
Studio installed on it, copy the sample application’s .mer file to the run-time 
computer. For more information, see Chapter 24 in the RSView Machine Edition 
User’s Guide.

To run a sample run-time application

1. In the RSView ME Station dialog box, click Load Application.

2. Select the sample application’s .mer file, and then click Open.

3. To replace the terminal’s current communication configuration with the 
application’s communication configuration, click Yes. To keep the 
terminal’s current communication configuration, click No.

The application name is displayed in the Current application text box in the 
RSView ME Station dialog box.

4. To run the application, click Run Application.
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Chapter
4 Running RSView ME Station 
on a PanelView Plus terminal

System requirements
To run RSView ME StationTM on a PanelView PlusTM terminal, the 
requirements are:

Available Memory (RAM). 64 MB.

Available Flash Storage space. 32 MB. 

PC cards. Optional cards for storing temporary files or data log files. 

Installing
The PanelView Plus terminal comes with RSView ME Station pre-installed.

Reinstalling
If necessary, you can reinstall (upgrade) RSView ME Station on the PanelView 
Plus terminal using the Firmware Upgrade Wizard. A firmware upgrade 
reinstalls ME Station and RSLinx EnterpriseTM as well as other programs.

To reinstall the firmware

Using the Firmware Upgrade Wizard, you can:

create a firmware upgrade card that can be plugged into a PanelView Plus.

update the firmware on a PanelView Plus that is connected by a network to 
a Windows® 2000/XP computer.

1. For information on installing and using the Firmware Upgrade Wizard, see 
Tech Note A 519616187 in the Rockwell Automation Knowledgebase.
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2. Follow the instructions in the wizard to reinstall or upgrade the firmware 
on your PanelView Plus.

For more information, see the Firmware Upgrade Wizard Help.

Starting
You can start RSView ME Station manually, or you can set up the program to 
start automatically when the PanelView Plus terminal is turned on. 

Starting RSView ME Station manually
You can use the options in the RSView ME Station dialog box to load, set up 
and run your application on the PanelView Plus terminal. For information 
about the options in the dialog box, see Chapter 25 in the RSView Machine 
Edition User’s Guide.

Starting automatically
You can set up RSView ME Station to start automatically and run a particular 
application when the PanelView Plus terminal is turned on. For more 
information, see Chapter 25 in the RSView Machine Edition User’s Guide.

Running applications
Before you can run an application on the PanelView Plus terminal, you must 
transfer it to the PanelView Plus terminal. 

For information about transferring applications to the PanelView Plus terminal 
and preparing to run them, see Chapter 25 in the RSView Machine Edition User’s 
Guide.

Using sample applications
RSView Studio comes with sample applications that highlight features of the 
product. Most of these applications have two run-time versions, designed for 
two different screen resolutions.
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For example:

Overview_640x480.mer
Overview_800x600.mer

The sample applications are located at this path on the development computer 
(the computer on which RSView Studio is installed):

\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects. 

HMI projects contains a folder for each sample application.

To run a sample run-time application

1. Transfer the application’s .mer file to the PanelView Plus terminal and 
prepare to run the application.

For detailed instructions, see Chapter 25 in the RSView Machine Edition 
User’s Guide.

2. Start RSView ME Station.

3. In the RSView ME Station dialog box, click Load Application.

4. Select the sample application’s .mer file, click the file name, and then click 
Load.

The application name is displayed in the Current Application name box in 
the RSView ME Station dialog box.

5. To replace the terminal’s current communication configuration with the 
application’s communication configuration, click Yes. If not, click No.

6. To run the application, click Run Application.
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Chapter
5 Running RSView ME Station 
on the VersaView CE 
terminal

System requirements
To run RSView ME StationTM on a VersaViewTM CE Industrial Computer, the 
requirements are:

Available Memory (RAM). 64 MB.

Available Storage Card space. 32 MB.

Operating system. Microsoft® Windows® CE.NET 4.1. 

PC cards. Optional cards for storing temporary files or data log files. 

Installing
The VersaView CE terminal comes with RSView ME Station already installed. 

Reinstalling
If necessary, you can reinstall (upgrade) RSView ME Station. There are two 
methods you can use; using ActiveSync®, and using the Firmware Upgrade 
Wizard.

Reinstall using ActiveSync when you have software other than RSView ME 
Station installed on your terminal that should not be removed. This process 
reinstalls the files associated with RSView ME Station only, and leaves all other 
files alone.
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Reinstall RSView ME Station using the Firmware Upgrade Wizard when only 
RSView ME Station is installed on your terminal. The Firmware Upgrade 
Wizard removes other programs and documents from the terminal during the 
upgrade process.

Using ActiveSync
The steps below explain how to install the RSView ME Station software from 
the CD-ROM on the PC to the VersaView CE terminal using ActiveSync.

To prepare for the upgrade

1. On a computer (PC) running Windows 2000 or Windows XP, install 
Microsoft ActiveSync 3.0 or higher.

ActiveSync 3.0 is included on the VersaView CE Applications and 
Accessories CD-ROM. You can also download the software from the 
Microsoft web site.

2. Connect the VersaView CE terminal to the PC, using the Allen-Bradley 
serial cable 2711-NC13. For details about wiring the cable, see the 
VersaView CE 6182H Operator Terminals User Manual.

3. Prepare the VersaView CE for a serial download. Follow the instructions in 
the VersaView CE 6182H Operator Terminals User Manual.

4. Insert the RSView Machine EditionTM CD in the PC’s CD-ROM drive.

To upgrade RSView ME Station

1. On the VersaView CE terminal, click the Windows Start button, select 
Programs > Communication, and then click Active Sync.

The VersaView CE terminal attempts to connect to the PC. If it does not 
connect immediately, check the steps in the previous section and make sure 
the cable is firmly connected. Restart the VersaView CE terminal and the 
PC, and then try again.

2. If the VersaView CE terminal still does not connect to the PC, open 
ActiveSync on the PC manually:

On the PC, click the Windows Start button, select Programs, and then click 
Microsoft ActiveSync.

3. On the PC, the Microsoft ActiveSync dialog box opens, and then the Get 
Connected dialog box should open. If the Get Connected dialog box does 
not open, on the File menu, click Get Connected.
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4. In the Get Connected dialog box, click Next.

The New Partnership dialog box opens.

5. When asked whether to set up a partnership, click No, and then click 
Next.

6. In the Microsoft ActiveSync dialog box, click Explore.

The VersaView CE is shown as a folder named Mobile Device.

7. In the Mobile Device folder, open the My Computer folder.

Inside the My Computer folder is a folder called Storage Card.

8. Browse the CD-ROM on the PC to the file Setup.exe.

9. Copy the file Setup.exe to the Storage Card folder on the VersaView CE 
terminal.

10. On the VersaView CE terminal, click the Windows Start button, and then 
click Run.

11. In the Run dialog box, type “\Storage Card\Setup.exe” (including the 
quotation marks).

The RSView ME Station Self-extracting dialog box opens and RSView ME 
Station begins to self-extract its program files.

12.When setup is complete, delete the file Setup.exe from \Storage Card.

Using the Firmware Upgrade Wizard
If necessary, you can reinstall (upgrade) RSView ME Station on the VersaView 
CE terminal using the Firmware Upgrade Wizard. A firmware upgrade 
reinstalls ME Station and RSLinx Enterprise as well as other programs.

To upgrade the firmware

Using the Firmware Upgrade wizard, you can:

create a firmware upgrade card that can be plugged into a VersaView CE 
terminal.

update the firmware on a VersaView CE terminal that is connected by a 
network to a Windows 2000/XP computer.

1. For information on installing and using the Firmware Upgrade Wizard, see 
Tech Note A 519616187 in the Rockwell Automation Knowledgebase.
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2. Follow the instructions in the wizard to upgrade the firmware on your 
VersaView CE terminal.

For more information about using the Firmware Upgrade Wizard, see Help.

Starting
You can start RSView ME Station manually, or you can set up the program to 
start automatically when the VersaView CE terminal is turned on. 

Starting RSView ME Station manually
Click the Windows Start button, select Programs > Rockwell Software, and 
then click RSView ME Station.

The RSView ME Station dialog box opens. For information about the options 
in the dialog box, see Chapter 25 in the RSView Machine Edition User’s Guide.

Starting automatically
You can set up RSView ME Station to start automatically and run a particular 
application when the VersaView CE terminal is turned on. For more 
information, see Chapter 25 in the RSView Machine Edition User’s Guide.

Running applications
Before you can run an application on the VersaView CE terminal, you must 
transfer it to the VersaView CE terminal. 

For information about transferring applications to the VersaView CE terminal 
and preparing to run them, see Chapter 25 in the RSView Machine Edition User’s 
Guide.

Using sample applications
RSView Studio comes with sample applications that highlight features of the 
product. Most of these applications have two run-time versions, designed for 
two different screen resolutions.
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For example:

Overview_640x480.mer
Overview_800x600.mer

The sample applications are located at this path on the development computer 
(the computer on which RSView Studio is installed):

\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects. 

HMI projects contains a folder for each sample application.

If you haven’t activated RSView ME Station, use the sample application 
Objects 5 Screen Demo.mer.

To run a sample run-time application

1. Transfer the application’s .mer file to the VersaView CE terminal and 
prepare to run the application.

For detailed instructions, see Chapter 25 in the RSView Machine Edition 
User’s Guide.

2. Start RSView ME Station.

3. In the RSView ME Station dialog box, click Load Application.

4. Select the sample application’s .mer file, click the file name, and then click 
Load.

5. To replace the terminal’s current communication configuration with the 
application’s communication configuration, click Yes. Click No to keep the 
terminal’s current communication configuration.

The application name is displayed in the Current application name box in 
the RSView ME Station dialog box.

6. To run the application, click Run Application.
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Chapter
6 Running RSView ME Station 
on a MobileView terminal

System requirements
To run RSView ME StationTM on a MobileViewTM terminal, the requirements 
are:

Available Memory (RAM). 64 MB.

Available Flash Storage space. 32 MB.

Operating system. Microsoft® Windows® CE.NET 4.1. 

PC cards. Optional cards for storing temporary files or data log files. 

Installing
The MobileView terminal comes with RSView ME Station pre-installed.

Reinstalling
If necessary, you can reinstall (upgrade) RSView ME Station. There are two 
methods you can use; using ActiveSync®, and using the Firmware Upgrade 
Wizard.

Reinstall using ActiveSync when you have software other than RSView ME 
Station installed on your terminal that should not be removed. This process 
reinstalls the files associated with RSView ME Station only, and leaves all other 
files alone.

Reinstall RSView ME Station using the Firmware Upgrade Wizard when only 
RSView ME Station is installed on your terminal. The Firmware Upgrade 
Wizard removes other programs and documents from the terminal during the 
upgrade process.
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Using ActiveSync
The steps below explain how to install the RSView ME Station software from 
the CD-ROM on the PC to the MobileView terminal using ActiveSync.

To prepare for the upgrade

1. On a computer (PC) running Windows 2000 or Windows XP, install 
Microsoft ActiveSync 3.1 or higher.

Download ActiveSync from the Internet at www.microsoft.com/
pocketpc/downloads/activesync.asp and follow Microsoft’s installation 
instructions.

2. Connect the MobileView terminal to the PC, using the Allen-Bradley serial 
cable 2727-MRC1. For details about wiring the cable, see the MobileView 
Machine Terminal MT-750 User Manual or the MobileView Guard Terminal G-
750 User Manual.

3. Prepare the MobileView for a serial download. Follow the instructions in 
the MobileView Machine Terminal MT-750 User Manual or the MobileView 
Guard Terminal G-750 User Manual.

4. Insert the RSView Machine EditionTM CD in the PC’s CD-ROM drive.

To upgrade RSView ME Station

1. On the MobileView terminal, click the Windows Start button, select 
Programs > Communication, and then click Active Sync.

The MobileView terminal attempts to connect to the PC. If it does not 
connect immediately, check the steps in the previous section and make sure 
the cable is firmly connected. Restart the MobileView terminal and the PC, 
and then try again.

2. If the MobileView terminal still does not connect to the PC, open 
ActiveSync on the PC manually:

On the PC, click the Windows Start button, select Programs, and then click 
Microsoft ActiveSync.

3. On the PC, the Microsoft ActiveSync dialog box opens, and then the Get 
Connected dialog box should open. If the Get Connected dialog box does 
not open, on the File menu, click Get Connected.

4. In the Get Connected dialog box, click Next.
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The New Partnership dialog box opens.

5. When asked whether to set up a partnership, click No, and then click 
Next.

6. In the Microsoft ActiveSync dialog box, click Explore.

The MobileView is shown as a folder named Mobile Device.

7. In the Mobile Device folder, open the My Computer folder.

Inside the My Computer folder is a folder called Storage Card.

8. Browse the CD-ROM on the PC to the file Setup.exe.

9. Copy the file Setup.exe to the Storage Card folder on the MobileView 
terminal.

10. On the MobileView terminal, click the Windows Start button, and then 
click Run.

11. In the Run dialog box, type “\Storage Card\Setup.exe” (including the 
quotation marks).

The RSView ME Station Self-extracting dialog box opens and RSView ME 
Station begins to self-extract its program files.

12.When setup is complete, delete the file Setup.exe from \Storage Card.

Using the Firmware Upgrade Wizard
If necessary, you can reinstall (upgrade) RSView ME Station on the 
MobileView terminal using the Firmware Upgrade Wizard. A firmware upgrade 
reinstalls ME Station and RSLinx Enterprise as well as other programs.

To upgrade the firmware

Using the Firmware Upgrade wizard, you can:

create a firmware upgrade card that can be plugged into a MobileView 
terminal.

update the firmware on a MobileView terminal that is connected by a 
network to a Windows 2000/XP computer.

1. For information on installing and using the Firmware Upgrade Wizard, see 
Tech Note A 519616187 in the Rockwell Automation Knowledgebase.
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2. Follow the instructions in the wizard to upgrade the firmware on your 
MobileView terminal.

For more information, see the Firmware Upgrade Wizard Help.

Starting
You can start RSView ME Station manually, or you can set up the program to 
start automatically when the MobileView terminal is turned on. 

Starting RSView ME Station manually
Click the Windows Start button, select Programs > Rockwell Software, and 
then click RSView ME Station.

The RSView ME Station dialog box opens. For information about the options 
in the dialog box, see Chapter 26 in the RSView Machine Edition User’s Guide.

Starting automatically
You can set up RSView ME Station to start automatically and run a particular 
application when the MobileView terminal is turned on. For more information, 
see Chapter 26 in the RSView Machine Edition User’s Guide.

Running applications
Before you can run an application on the MobileView terminal, you must 
transfer it to the MobileView terminal. 

For information about transferring applications to the MobileView terminal 
and preparing to run them, see Chapter 26 in the RSView Machine Edition User’s 
Guide.

Using sample applications
RSView Studio comes with sample applications that highlight features of the 
product. Most of these applications have two run-time versions, designed for 
two different screen resolutions.
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For example:

Overview_640x480.mer
Overview_800x600.mer

The sample applications are located at this path on the development computer 
(the computer on which RSView Studio is installed):

\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects. 

HMI projects contains a folder for each sample application.

To run a sample run-time application

1. Transfer the application’s .mer file to the MobileView terminal and prepare 
to run the application.

For detailed instructions, see Chapter 26 in the RSView Machine Edition 
User’s Guide.

2. Start RSView ME Station.

3. In the RSView ME Station dialog box, click Load Application.

4. Select the sample application’s .mer file, click the file name, and then click 
Load.

The application name is displayed in the Current application name box in 
the RSView ME Station dialog box.

5. To replace the terminal’s current communication configuration with the 
application’s communication configuration, click Yes. If not, click No.

6. To run the application, click Run Application.
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Chapter
7 Getting the information you 
need

Using the User’s Guide
The RSView Machine Edition User’s Guide provides step-by-step procedures and 
reference information for working with all the features in RSView StudioTM and 
RSView ME StationTM. It provides detailed information about creating and 
running applications. 

To view the User’s Guide while RSView Studio is running:

On the RSView Studio menu bar, click Help, select Online Books, and then 
click User’s Guide.
This Installation Guide is also available from the Help menu.

If desired, you can print the online User’s Guide. For more information, see 
Adobe® Acrobat® ReaderTM Help.

Using RSView Studio Help
RSView Studio Help provides step-by-step procedures and reference 
information for working with all the features in RSView Studio. 

To open Help while RSView Studio is running

Click the Help button on any window.
OR

On the RSView Studio menu bar, click Help, and then click Contents.
OR

Press the F1 key.
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Viewing the Help contents
For an overview of RSView Studio Help, click the Contents tab. 

To see the topics in
a book, click the +.

To see a topic, click
the topic.
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Using the index
The Help index is similar to an index in a book, listing keywords for topics in 
Help. To see the index, click the Index tab.
Getting the information you need     37



Finding words or topics
To search the entire text of the Help, click the Search tab.

Scroll through
the list to find the

term you’re
looking for.

When you find
the term, double-

click it to go to
that topic.

Type the word to
search for here,

and then click
List Topics.
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Using the RSView online user’s guides
The RSView CD-ROM includes the following manuals:

RSView Machine Edition User’s Guide

RSView Machine Edition Installation Guide

The RSView CD-ROM also includes the Adobe Acrobat Reader software for 
viewing the guides. You can print all or part of the guides, and you can copy 
text and graphics from the guides and paste them into other documents.

Viewing the guides
To access the user’s guides, click Help, point to Online Books, and then click 
the name of the book you want to view.

Finding information

You can search the online guides for a particular word or phrase.

To find a word or phrase:

1. Do one of the following:

on the toolbar, click the Find tool 

on the Edit menu, click Find

2. In the Find dialog box, type the word or phrase you want, and then click 
Find.

The word or phrase is highlighted in the text. To find another instance of 
the word or phrase, click Find Again on the Edit menu.

Find tool
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Printing pages

You can print selected text, single pages, or an entire guide.

To print selected text:

1. On the File menu, click Page Setup, then select and set up the printer you 
will use.

2. On the toolbar, click the Text select tool, and then select the text you want 
to print

3. On the File menu, click Print.

4. In the Print dialog box, ensure the correct printer is selected, click Selected 
pages/graphic, and then click OK.

To print one or more pages:

1. On the File menu, click Page Setup to select and set up the printer you will 
use.

2. On the File menu, click Print.

3. In the Print dialog box, ensure the correct printer is selected, click Current 
Page or specify Start and End pages, and then click OK.

Using the online guide for the reader

For more information about the Adobe Acrobat Reader, see the Adobe 
Acrobat online guide. To open the online guide while Adobe Acrobat Reader 
is running, click Help on the menu bar and then click Reader Help.

Text select tool
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Technical Support Services
You have many options for finding information about using RSView, or 
solving problems with RSView.

Try the user’s guides and Help first

The RSView user’s guides and Help provide comprehensive information about 
typical uses of RSView. Quite likely your question is answered in the 
documentation.

To find the answer, use the table of contents and the index in the user’s guides 
and Help.

Information on the Internet

If you can’t find the answer to your question or problem in the user’s guides or 
Help, you can also find information on the World Wide Web.

Accessing support pages on the Internet

To access Rockwell Software’s support pages on the Internet from within 
RSView, click Help, point to Rockwell Software on the Web, and then click the 
name of the web page you want to view.

To use Rockwell Software on the Web, you must have a web browser installed 
on your computer, and you must have an active Internet connection.
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The Rockwell Software support web sites

World Wide Web Support web site:
http://www.software.rockwell.com
http://support.rockwellautomation.com

The Rockwell Software support web sites include comprehensive searchable 
databases of support information for all Rockwell Automation and Rockwell 
Software products.

The RSView ME Forum

http://www.software.rockwell.com/forum/rsviewme/

The RSView ME Forum is a web site for users like you. The RSView Forum 
offers:

an RSView frequently-asked questions (FAQ) list, for information about 
how to solve the problems our technical support teams encounter most 
often

discussion groups, for exchanging tips and questions with other RSView 
users

design resources, to help you put together graphic displays, VBA code 
samples for extending the functionality of RSView, and ready-made 
ActiveX objects you can use in your own RSView applications

information about what’s new, including product announcements, new 
articles and information provided by Rockwell Software

The RSView ME Knowledge Base

To access the Knowledge Base, go to the Rockwell Software Home Page 
(http://www.software.rockwell.com/). From the menu bar, select Support > 
Online support > knowledgebases.

The Knowledge Base is a searchable database of technical notes and 
frequently asked questions updated daily by our support specialists.
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Contacting Rockwell Software Technical Support
If you can’t find the answer to your question using any of the resources 
suggested above, contact Rockwell Software Technical Support at:

Telephone
440–646–5800

Fax
440–646–5801

Support staff are available Monday through Friday from 8 AM to 5 PM local time 
(North America only), except during holidays.

World Wide Web Support web site:
http://www.software.rockwell.com
http://support.rockwellautomation.com/contactinformation

When you call

When you call, you should be at a computer and prepared to give the following 
information:

the product serial number

You can find this number on the Activation disk label and in the Help 
About dialog box in RSView Studio.

the product version number

the type of hardware you are using

the exact wording of any messages that appeared on your screen

a description of what happened, and what you were doing when the 
problem occurred

a description of how you tried to solve the problem

You may also be required to provide information about the RSView add-ons 
and updates that are installed on your computer.
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To view the list of installed add-ons and updates:

1. With the Application Explorer window active, click Help, and then click 
About RSView Studio.

2. Click Add-ons to view the list of installed add-ons.

3. Click Updates to view the list of installed updates.
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